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Correlating Science Labs and Science Writing

I have found 11 labs that match each of the content standards for Chemistry and created a writing component for each of them. My idea is that some students (okay, maybe a lot of students) have a hard time feeling connected to their Chemistry class content.  They may be uninterested in the subject or have a hard time with the mathematical concepts.  The writing assignments are designed to make the student feel more ownership of their education.

Grade Level: High School Chemistry

Timeline: One lab per unit, writing assignments printed in a quarterly newsletter or the school newsletter.

Science Content Standards:
Covering all of the Chemistry Standards, Investigation and Experimentation Standards will vary from class to class.

Correlating Science Labs and Science Writing
My RET I research was done in the Electrical and Computer Engineering lab.  I worked with Milan Masanovic on a project involving an optically tunable wavelength converter.  This subject was really, really hard for me to understand, much less enjoy at first.  I soon realized that what Milan had really designed was this little circuit that decoded and encoded messages from telephones and other telecommunication devices.  There was this really steep learning curve and once I discovered a way to be interested in optically tunable wavelength converters the rest of the project was fun. I did research on my own on how information is encoded into 1’s and 0’s, looked up telecommunication systems history and put it all together in a PowerPoint presentation for my RET I group.

I want my students to have fun learning.  My independent research was exciting for me and helped me simplify the highly technical information I was hearing from my mentor. My idea for RET II is to develop curriculum that has an independent research and writing component that is tied to a laboratory exercise that we’ve done in class.

I’ve chosen eleven labs that are directly correlated to the California standards for Chemistry and added a writing component to them.  The idea behind this curriculum could be used in any lab class.  For instance, in a physics class a teacher could take a lab they already use and assign a similar writing component.  The end result of this project is a Quarterly Newsletter (it could even have a science geek title, i.e.  MoleTimes) in which every student has something published.

Teacher’s Guide to Correlating Science Labs and Science Writing

Introduction:

The following steps are written for Chemistry because that is what I teach but can easily be modified for any lab class. I found a lab for every unit/standard that I need to cover during the school year. There is a writing assignment that is not part of their lab reports included with each lab.  The end result is a quarterly newsletter or insert in the school newspaper.

Equipment and Materials:

Software for creating a newsletter (i.e. Microsoft Publisher)

Set of Labs for your subject 

Learning Objectives:

Science Labs and Writing skills are correlated with California standards 

Before the School Year:

· Coordinate writing project with English teacher if possible

· Decide on writing assignments to include in selection for students

Before the Lab:

· Go over Rubrics with students. Have them keep a copy in their lab notebook.

· Talk about the options they have for response to a lab. Give specific examples. For instance, during the periodic table lab a student could write about science as it was during Mendeleev’s time or the process of alchemy.

· Set a due date for the independent writing project

After the Lab:

· Collect writing assignments on disc or store them on a hard drive.

· Submit to school newspaper or assign students to design newsletter.

Writing Options for Each Lab Experiment

Directions:  For each lab/experiment we do in the classroom you will have an independent writing assignment.  Essays should be fairly short so that they can fit into the newsletter format.  There should be from 250 to 500 words.

Options:

Biography

Write a biography on one of the scientists involved in the original research. See Research Essay Rubric.

Opinion

Write an opinion piece about some controversy surrounding this research topic.  See Research Essay Rubric.

Experiment Results

Write up your lab in essay format.  See Lab Report Rubric.

Obituary

Write up an obituary for a scientist involved in the original research.  See Research Essay Rubric.

Interesting Fact

Write an essay on some part of the research you found particularly interesting. (For example aspirin originally was extracted from the bark of the willow tree. Do some research on the origins of aspirin, native uses etc.) See Research Essay Rubric.

Extra Credit:

Comic Strip

Crossword Puzzle

Bumper sticker Slogan

Putting the Newsletter Together

Newsletter Rubric

Name______________________________

	Category
	4
	3
	2
	1

	Writing Organization
	Each section in the newsletter has a clear beginning, middle, and end.
	Almost all sections of the newsletter have a clear beginning, middle and end.
	Most of the sections of the newsletter have a clear beginning, middle and end
	Less than half of the sections of the newsletter have a clear beginning, middle and end.

	Writing

Grammar
	There are no grammatical mistakes in the newsletter.
	There are no grammatical mistakes in the newsletter after feedback from the teacher
	There are 1-2 grammatical mistakes in the newsletter even after feedback from the teacher.
	There are several grammatical mistakes in the newsletter even after feedback from the teacher.

	Content - Accuracy
	All facts in the newsletter are accurate.
	99-90% of the facts in the newsletter are accurate.
	89-80% of the facts in the newsletter are accurate.
	Fewer than 80% of the facts in the newsletter are accurate.

	Attractiveness & Organization
	The newsletter has exceptionally attractive formatting and well-organized information.
	The newsletter has attractive formatting and well-organized information.
	The newsletter has well-organized information.
	The newsletter's formatting and organization of material are confusing to the reader.

	Sources
	Careful and accurate records are kept to document the source of 95-100% of the facts and graphics in the newsletter.
	Careful and accurate records are kept to document the source of 94-85% of the facts and graphics in the newsletter.
	Careful and accurate records are kept to document the source of 84-75% of the facts and graphics in the newsletter.
	Sources are not documented accurately or are not kept on many facts and newsletter.


Total Score:________/20

Research Report Rubric

Name_________________________

	Category
	4
	3
	2
	1

	Quality of Information
	Information clearly relates to the main topic. It includes several supporting details and/or main examples
	Information clearly relates to the main topic.  It provides 1-2 supporting details and/or examples.
	Information clearly relates to the main topic.  No details and/or examples are given.
	Information has little or nothing to do with the main topic.

	Amount of Information
	All topics are addressed and all questions answered with at least 2 sentences about each.
	All topics are addressed and most questions answered with at least 2 sentences about each.
	All topics are addressed, and most questions answered with 1 sentence about each.
	One or more topics were not addressed.

	Mechanics
	No grammatical, spelling or punctuation errors.
	Almost no grammatical, spelling or punctuation errors.
	A few grammatical,  spelling or punctuation errors.
	Many grammatical, spelling or punctuation errors.

	Diagrams & Illustrations
	Diagrams and illustrations are neat, accurate and add to the reader's understanding of the topic.
	Diagrams and illustrations are accurate and add to the reader's understanding of the topic.
	Diagrams and illustrations are neat and accurate and sometimes add to the reader's understanding of the topic.
	Diagrams and illustrations are not accurate OR do not add to the reader's understanding of the topic.

	Sources
	All sources (information and graphics) are accurately documented in the desired format.
	All sources (information and graphics) are accurately documented, but a few are not in the desired format.
	All sources (information and graphics) are accurately documented, but many are not in the desired format.
	Some sources are not accurately documented.


Total Score:__________/20
Lab Report Rubric  Name_________________________________
	CATEGORY
	4
	3
	2
	1

	Experimental Hypothesis
	Hypothesis and Experiment are directly related and incorporate what has been studied in class.
	Hypothesis and Experiment are both based on what has been studied in class.
	Hypothesis and Experiment have been stated but there are factual errors.
	No hypothesis has been stated.

	Experimental Design
	Experimental design is a well-constructed test of the stated hypothesis.
	Experimental design is adequate to test the hypothesis, but leaves some unanswered questions.
	Experimental design is relevant to the hypothesis, but is not a complete test.
	Experimental design is not relevant to the hypothesis.

	Scientific Concepts
	Report shows an accurate and thorough understanding of scientific concepts underlying the lab.
	Report shows an accurate understanding of most scientific concepts in the lab.
	Report shows a limited understanding of scientific concepts in the lab.
	Report shows inaccurate understanding of scientific concepts underlying the lab.

	Analysis
	The relationship between the variables is discussed and analyzed. Predictions are made about what might happen if part of the lab were changed or how the experimental design could be changed.
	The relationship between the variables is discussed and trends/patterns logically analyzed.
	The relationship between the variables is discussed but no patterns, trends or predictions are made based on the data.
	The relationship between the variables is not discussed.

	Conclusion
	Conclusion includes whether the findings supported the hypothesis, possible sources of error, and what was learned from the experiment.
	Conclusion includes whether the findings supported the hypothesis and what was learned from the experiment.
	Conclusion includes what was learned from the experiment.
	No conclusion was included in the report OR shows little effort and reflection.

	Appearance/

Organization
	Lab report is typed and uses headings and subheadings to visually organize the material.
	Lab report is neatly handwritten and uses headings and subheadings to visually organize the material.
	Lab report is neatly written or typed, but formatting does not help visually organize the material.
	Lab report is handwritten and looks sloppy with cross-outs, multiple erasures and/or tears and creases.

	Data
	Professional looking and accurate representation of the data in tables and/or graphs. Graphs and tables are labeled and titled.
	Accurate representation of the data in tables and/or graphs. Graphs and tables are labeled and titled.
	Accurate representation of the data in written form, but no graphs or tables are presented.
	Data are not shown OR are inaccurate.


Total Score:___________/28
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Name: ___________________________ 

Periodic Table Logic Puzzle
The object of this lesson is to use the periodic properties of the elements to fill in the following chart (on back). The code letters A to Z have been assigned to the first 26 representative elements in the periodic table. The code letters do not represent certain chemical symbols, that is, C may not be carbon, nor have the letters been assigned in alphabetical order.

These letters are presented in families, and your task is to arrange these letters in the proper location in the periodic chart. To do this, use the clues given pertaining to certain members of each family. The numbers in each square in the table are the atomic numbers of the elements.

The best way to start is to use the clues to find in which group each family belongs, and then to arrange the elements within the family using the other clues. The following elements belong together in families: WXYZ, STUV, ABC, DEF, GHI, JKL, MNO, and PQR.

 

Clues:
1. Element M is not the largest in its group and will react with element O to form both MO3 and MO2 .

2. Elements L & E are from the same period.

3. The radius of atoms of element P are smaller than the atoms of element R.

4. Element T has the lowest ionization potential in its group.

5. Element W is more reactive than element A and element A is more reactive than element D. All three elements are in the same series.

6. The radius of atoms of element H are smaller than atoms of element I.

7. Element B is the least reactive alkaline earth element.

8. The Lewis dot notation for element K is [image: image2.jpg]


.

9. When elements K and L react L has a positive oxidation state.

10. Element Q is the most electronegative element.

11. The atomic number of element V is one more than element P.

12. Element J is the most non-metallic element in its group.

13. Elements C & N are from the same period and react to form CN .

14. The oxidation state of element O is 2- in almost all compounds except when bonded to atoms of element Q.

15. Element Z is the most active metal in its period.

16. The atomic number of Z is 16 more than the atomic number of Y.

17. Element E reacts with element P to form EP3 .

18. Element U is the smallest (size of the atoms) element in its period , but not in its group.

19. Element G has the highest ionization potential in its group.


The following Periodic Table shows only the Group A elements. Note that the atomic numbers jump from 20 to 31 in the fourth period. This is because elements 21 through 30, the transition elements, belong to the B Groups.
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Answers to Periodic Table Logic Puzzle

Going down the groups:

Group I: X, Y, W, Z

Group II: B, A, C

Group III: F, D, E

Group IV: G, H, I

Group V: J, K, L

Group VI: O, M, N

Group VII: Q, P, R

Group VIII: S, U, V, T
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Demonstration: Magnetic Analogy for Bonding Forces

Purpose 

To demonstrate the electrostatic attraction and repulsion between like and unlike charges using a magnetic analog. 

Materials 

· 4 ceramic ring or disk magnets 

· Overhead projector and screen 


Procedure 

Begin the demonstration by showing on the overhead projector that like poles repel and unlike poles attract. Draw an analogy to attraction and repulsion between electric charges. 

Set up two pairs of magnets so that each pair is attractive. This will illustrate the attraction between the nucleus and an electron. Move one pair into the center of view. Then approach with the other pair in so that one "nucleus" approaches the other "nucleus." No attraction is observed. Move this pair so that the "electrons" are between the two "nuclei." This leads to a stable arrangement. 

With the stable arrangement in the center, show that if either "electrons" or "nuclei" are forced closer together, they repel. Thus an "equilibrium distance" between particles with like charges is created.


Remarks 

This demonstration takes 15 min. or less to prepare and present, depending upon availability of disk or circular magnets. The demonstration should be presented when covalent bonding is introduced. 

Practice with the magnets prior to doing the demonstration. It requires patience to move the magnets carefully to show formation of a "bond". Either ring or disk magnets may be used, but the magnets should be face-magnetized, that is, faces should be the poles. It's possible to use ring magnets to represent the nuclei and disk magnets to represent the electrons. In either case, use larger-diameter magnets for nuclei and smaller-diameter magnets for electrons. 

The materials may be saved and used many times. Ceramic magnets are somewhat fragile and should not be dropped. Edmund Scientific, Radio Shack, and similar sources can supply these magnets. Disk magnets are also frequently available at hobby shops and craft shops. 

Point out that this is an analogy to the electrostatic forces that cause a covalent bond to form. Both magnetic and electrostatic forces behave the same way; like charges or poles repel and unlike ones attract. Point out that a "nucleus-electron" pair is stable because there's only one attractive force and no repulsive forces. When two pairs approach, new attractive forces arise between the "nucleus" of one pair and the "electron" of the other pair, and vice versa. New repulsions also are present between the two "nuclei" and the two "electrons." The result is four attractions but only two repulsions, hence the two pairs form a stable arrangement. 
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Acids and Bases

Teacher:

I got this lab from www.chemfiesta.com, a website run by Ian Guch.  I highly recommend his site for labs, worksheets etc. They are all free.  I did buy a book he wrote called 24 Lessons that Rocked the World. It’s a great lab book.

This lab is very basic and can be expanded to cover even more of the standards.  I combine this lab with a research paper on chemistry in the old days, i.e. alchemy, snake-oil peddlers.
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Making Medieval Messes
The year is 1450. You are the chemist for a small town in Europe.  One of the villagers has brought you two flasks; one contains an acid, and the other contains a base.  The problem is that the labels have fallen off of the flasks, and he doesn’t know which flask contains which solution.

As town chemist, your job is to determine which of the flasks contains acid and which contains base.  Because of your limited technology, you have only the following materials:

Acidic solution

Basic solution

Extract of cabbage

Test tubes

Goggles (These you must use, no matter how you solve the problem!)
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Surface Area and Reaction Rate 

This is an oldie but goodie for demonstrating how increased surface area leads to increased rate of reactions. 

Materials: flour large coffee can with lid or ice cream tub with lid candle 3 ft of tubing small plastic or metal can (prescription bottle or tomato juice can) bunsen burner spatula or spoon 

Set Up: Run the tubing thru the side near the bottom of the large can and to the side near the bottom of the small can. The small can should be upright and in the middle of the large can. The diameter of the tubing should be large enough so that when the small can is half full of flour it can be finely dispersed by blowing vigorously into the end of the tubing. 

Procedure: Demonstrate with flour on a spoon and a bunsen burner that flour is not very flammable under normal conditions. When finely dispersed the reaction goes much faster. Light the candle. Put the lid on the large can and blow long and hard into the tubing. You will get a nice "whump" and the lid will blow off and about 6" to 1' of flame will shoot out of the large can for an instant. There will be a slight smell of burnt protein and a little flour dust on the table but no large mess. As always you will want to have safety glasses on and an extinguisher nearby. Variations: wood dust, powdered coal (could be very powerful. Be careful.) 
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Properties of alcohols

Introduction

Alcohols are an important group of organic chemicals. The alcohol people drink is called ethanol and is produced by fermentation. Alcohols are characterized by an –OH group attached to a carbon atom.
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What to record

What was observed.

What to do

1. 
Take a small quantity of ethanol and add the same volume of water. What is the pH of the mixture? Test the mixture with full range indicator solution. Does the water mix with the ethanol?

2. 
Put a small quantity of ethanol on a tin lid and ignite it with a splint. Does it burn, and if so, describe the flame.

3. 
Put 5 cm3 of dilute sulfuric acid in a boiling tube. Add five drops of potassium dichromate(VI) solution. Now add two drops of ethanol and heat the mixture until it just boils. Is there any sign of a reaction? Is there any change of smell that could come from a new compound?

Safety

Ethanol is highly flammable. Potassium dichromate (VI) is toxic. Wear disposable gloves. Avoid skin contact. Wash hands after use.

Questions

1. 
What is the name of the process used to produce ethanol on a commercial scale?

2. 
The reaction of an alcohol to produce an acid is called an oxidation reaction. What is the opposite reaction called that produces an alcohol from an acid?

3. 
Write a chemical equation for the combustion of ethanol.
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Radioactive Cookies
Protecting yourself from different radiations


You are handed 4 cookies. Each one of the cookies emits radiation. As a Health Physicist, you must decide what to do with each one of the four cookies. The decisions that you make must minimize the danger of radioactive exposure to yourself. Here are the restrictions on what you can do with the cookies.

1.) You must eat one of the cookies.

2.) You must dispose of one of the cookies at a state-of-the-art radioactive waste storage facility called WIPP (you can do this for free since no one else is ever going to use WIPP). Choosing this option removes the danger of this cookie entirely.

3.) You must put one of the cookies in your pocket.

4.) You must hold one of the cookies in your hand.

A radiation survey is done on the cookies and you find out that:

-Cookie 1 is an alpha emitter.

-Cookie 2 is a beta emitter.

-Cookie 3 is a gamma emitter.

-Cookie 4 is a neutron emitter.

Make your decisions on what to do with the cookies!

[image: image12.png]



Radioactive Cookies Answer:

The key to correctly deciding what to do with each cookie is to know something about the penetrating abilities of the four types of radiation.

Alpha particles are the nucleus of a helium atom. They are big and heavy containing two protons and two neutrons each. Their penetrating ability however is very small. They can only penetrate about 0.0066 cm of tissue. The second big hint for alpha particles is for you to find out on your own how thick the dead skin layer around your body is.

Beta particles are electrons. Electrons are very light, for instance they are about 8000 times lighter than an alpha particle. Even very high-energy beta particles can only penetrate between 0.5 cm and 1 cm of material.

Gamma rays are high-energy photons emitted from the nucleus of an atom. They have energies in the MeV range (that stands for millions of electron volts). Gamma rays do not have a charge, and this helps them to penetrate matter extremely well. The gamma rays from this cookie could probably be detected outside the room that it is placed in. While gamma rays are high energy with high penetrating ability, they have no mass.

Neutron radiation is nasty stuff. A neutron is a heavy particle, weighing in at 1/4 the mass of the alpha particle. The unique thing about the neutron is that while it is heavy, it has no charge (it is neutral). This lack of charge gives it the ability to penetrate matter without interacting as quickly as the beta particles or alpha particles. Then after penetrating the material, when the neutron does interact it behaves like a bowling ball thrown into a room full of Ping-Pong balls.
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Internet Resources Used

http://ir.chem.cmu.edu/irproject/curriculum/
-virtual labs and some extras

http://allserv.ugent.be/~tkuppens/chem/index.shtml
-has links to free chem. software

www.chemistrycoach.com
-go to the links for teacher’s section at the bottom of the page

http://www.enc.org/
-website for math and science teachers

http://www.mrl.ucsb.edu/mrl/outreach/edu_out/RET/ProjectPages/JTaylor.html
-my project RET I and II, has links to labs for every chemistry standard

http://www.mtsn.org.uk/acdepts/science/essays.htm
-science/research report writing

http://www.aresearchguide.com/1steps.html
-more on scientific writing

http://chem.lapeer.org/
-lots and lots of labs

http://chemistry.beloit.edu/modules.html
-cool modules

http://mc2.cchem.berkeley.edu/Organic/
-organic naming test questions

http://littleshop.physics.colostate.edu/default.html
-physics hands on stuff

http://www.itlearningmaterials.com/mspublisher.htm
-templates for newsletters and all sorts of publishing materials
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Creating a Newsletter
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Creating a school newsletter with Publisher 2000 helps you organize text and graphics. You can use a newsletter to communicate information and ideas to students or to the community. Your students can use the newsletter to develop skills in acquiring information, organizing it, and communicating it to others.

Because the newsletter can include various types of information, it is an excellent tool for students to present research to teachers and peers. Use the Newsletter Wizard to create a newsletter layout and add different types of articles based on research your students have done in and out of the classroom. 

Pre-publishing Activities

· Identify newsworthy topics that focus on timeliness, impact, and interest.

· Discuss the different features of a newsletter, such as a feature story, news story, advertisement, comic strip, letter to the editor, and editorial. 

· Have students look at examples of journalistic writing and discuss news writing style, concise wording, persuasion, descriptive language, and tone. 

· Identify the audience for your newsletter, and what they needs to know about your research and fundraising event. Write with that goal in mind.

· Discuss and gather information about a local current event topic and have students write an editorial about it.

Use It!

Designing with the Newsletter Wizard

The Publisher 2000 Newsletter Wizard helps you create a professional looking layout for your newsletter. The Newsletter Wizard takes you step-by-step through the design process by asking you questions about layout, color scheme, and printing. 

This lesson will guide you through creating a four-page newsletter with your own articles. You will be able to add pages with various layout designs and add graphics with captions that enhance your articles.

To use the Newsletter Wizard

1. If the Microsoft Publisher Catalog is not visible, click New on the File menu.

2. Click the Publications by Wizard tab.

3. In the Wizards pane, click Newsletters.

4. Click Blends Newsletter and then click Start Wizard. 

5. Read the introduction, and then click Next.

6. Select Mountain and then click Next.

7. Select 2 Columns and then click Next.

8. Select the No option and then click Next.

9. Select the Other Address option and then click Next. 

10. Select the Double-Sided option and click Next. 

11. Select the Other Organizations option.

12. Click Finish.

13. Save your newsletter by clicking Save on the File menu.

Customizing your newsletter

Now that you've created the basic newsletter layout, you can drop in headlines, articles, and clip art to customize your newsletter.

To enter information on the first page of your newsletter

13.  Zoom in on the publication in one of the following ways:

· On the Standard toolbar at the top of the screen, click the plus sign (+) to zoom.

· Click the Zoom drop-down box next to the plus and minus signs and then select a magnification from the list.

· Press F9.

14. If you created a Personal Information set in the last lesson, the Business Name should already be entered in the appropriate field. If you did not create the Personal Information set, then refer to the "Creating a Calendar" lesson in this guide to create the set. 

15. Click the placeholder text "Newsletter Title" and type Marine Mammals Newsletter. AutoFit is activated, so the text will get smaller as you type to fit in the text box.

16. Click the placeholder text "Newsletter Date" in the upper-right corner of the newsletter and then type Spring or the month your newsletter will be published.

17. Click the placeholder text "Lead Story Headline" and type Plan to Save Whales Causes Controversy or the title of your lead story.

18. Click the placeholder text below the Lead Story Headline. Type your story into this frame or paste a story into the frame from Microsoft Word (or other word-processor).

19. Double-click the lead story graphic. When the Clip Gallery appears, select a graphic appropriate to your story. For more information on selecting graphics, see the "Getting Your Bearings" lesson earlier in this guide.

20. Click the text "Secondary Story Headline" and type Reestablishing whale pods or the title of your secondary story.

21. Click the placeholder text below the Secondary Story Headline. Type your story directly into this frame, or paste a story into the frame from Microsoft Word (or other word-processor).

22. In the "Inside this Issue" frame, click anywhere on the text "Inside Story" and type the title of the next article you want in the newsletter. Add as many stories as you plan to have in your newsletter. 

23. On the File menu, click Save to save the changes you have made to your newsletter.

To insert an existing story

24. Create and save your story using your word processing software.

25. In the Newsletter, click anywhere in the text frame.

26. On the Insert menu, click Text File.

27. Select the word processing file with the story you want to insert.

28. Click Insert. The story will appear in the text frame.

To enter information in the inside of the newsletter

29. To go to the second page of the newsletter, click the page icon with the number 2 on the Status Bar, which is at the bottom of the Publisher window. You should see a page icon for each of the pages currently in your newsletter.

30. On the Newsletter Wizard in the left pane, click Inside Page Content. The Inside Page Content Wizard allows you to change the layout of the page to accommodate the information types you may want to add to the newsletter.

31. In the lower-left pane, click the Calendar with 1 story option. The page layout now has a calendar much like the calendar you created in the previous lesson. For more information on adding information to the calendar, see the "Creating a Calendar" lesson in this guide.

32. In the drop-down box in the left pane, select Right Inside Page.

33. Click the Response form with 1 story option. The page now has one story and a form that can be used to accept donations for a fundraising event.

34. Continue to customize headlines and articles as described earlier in this lesson.

35. On the File menu, click Save to save the changes you have made to your newsletter.

Entering captions for graphics

No matter how good an illustration is, a caption can tell the readers even more. In the newsletter, each of the Picture frames also has a caption frame attached. You can also insert caption frames in your publications.

To change the caption

36. Click the story graphic on the bottom of page 2.

37. Press F9 to get a closer look at the caption.

38. Click the caption and type a sentence describing the significance of the graphic or picture to your lead story.

39. Click outside the Text Frame.

40. Press F9 to zoom out to see the whole page again.

Adding or deleting extra pages

The newsletter you created may contain fewer or more pages than you'll need. Adding and deleting pages is simple. If you need six pages to fit the content in your newsletter, follow the instructions for adding extra pages. If you need only two pages to fit the content in your newsletter, follow the instructions for deleting extra pages.

To add extra pages

41. On the Insert menu, click Page. The Insert Page dialog box appears.

42. In the Left Page drop-down box, select the layout you want for the page.

43. In the Right Page drop-down box, select the layout you want for the page.

44. Click OK to add two pages.

To delete extra pages

45. To go to the second and third pages of the newsletter, click the page icon with the number 2 or 3, which is at the bottom of the Publisher window.

46. On the Edit menu, click Delete Page.

47. Select Both pages.

48. Click OK to delete the pages.

Inserting a Drop Cap

Sometimes a fancy first letter (called a Drop Cap) in a paragraph catches the reader’s attention. The Drop Cap can also help fill a page that does not have a lot of text. In order to perform this task, you must already have a story in the text frame.

To insert a Drop Cap

49. Go to the lead story on page 1 of the newsletter.

50. Click the lead story text frame on the first paragraph. If you have not already added a story in this text frame, then add at least one line of text before continuing.
51. On the Format Menu, click Drop Cap.

52. Click the Drop Cap tab, if necessary, and then click one of the drop-cap options in the Available drop cap box. You can scroll in the Available drop cap box to see additional drop-cap options.

53. Click OK to add the drop cap you selected.

Checking your spelling

Publisher 2000 includes some of the same features found in Microsoft Word, including background spell checking. Publisher 2000 also has a spelling option on the Tools menu.

To check your spelling

54. If you misspell a word or Publisher 2000 does not recognize it, a red wavy line appears directly beneath the word on the screen. Right-click the underlined word to see suggested spelling option. 

55. You can choose a correction, add the word to the dictionary, or tell Publisher 2000 to ignore all instances of the word.

56. On the Tools menu, point to Spelling, and then click Check Spelling. The spell checker checks one story at a time. A dialog box appears at the end of the first story asking if you want to check the rest of the publication.

57. Click OK to continue checking spelling. The Check Spelling dialog box appears when a misspelled word is found. You can change, ignore, or add the word to the dictionary.

Converting your newsletter to a Web site

Publisher 2000 lets you convert any publication to HTML, so the publication can be viewed with a Web browser. If you create a Newsletter or Brochure publication in Publisher 2000, you can easily transfer its content to a Web site with a Web layout. This is useful when the information you present and promote in the newsletter is of interest to students and to your entire community.

To publish your newsletter on the Web or school Intranet

58. In the newsletter you have created, click Show Wizard (unless the wizards are already visible).

59. In the top Wizard pane, click Convert to Web Site.

60. In the bottom Wizard pane, click Create.
61. In the Convert to Web Site dialog box, click OK.
The newsletter content appears in the Web site format.

62. On the File menu, click Save as Web Page. The page is saved in the folder you select.

63. On the File Menu, click Web Page Preview.

64. On the Web Page Preview dialog box, click OK to view your newsletter with a Web browser.

65. When you're finished previewing your Web site, close your Web browser.

Scan personal photos to add to a personal newsletter. If you write about a school event in the newsletter, include photos from the event. You can also scan original student art projects and school logos to include in your newsletter. You scan pictures directly into Publisher 2000. 

To replace a graphic with a scanned image

66. Place your photo on the scanner and scan the image.

67. In Publisher 2000, right-click the graphic you want to replace.

68. Point to Change Picture, then point to Picture, then point to From Scanner or Camera, and then click Acquire Image. Publisher 2000 will find the scanner and import the image. To learn more about scanning graphics into Publisher 2000, ask the Office Assistant "How do I add a picture from my scanner?"

· Explore the Clip Gallery and add additional graphics to your newsletter to add interest.

· For an editorial article, collect quotes from several people voicing their opinions regarding a school, community, or national current event.

· Volunteer to create and publish a newsletter for a non-profit organization in your community. Students can gather information from the organization and the community.

Assign students roles as editors, copyeditors, reporters/writers, and layout designers to create a club or school organization newsletter. Then have students plan, design, create, and distribute the newsletter within the school and the community.







Note:  


To preview a Web publication, you need a Web browser. The Microsoft Internet Explorer browser is included on the Publisher 2000 CD.
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Lesson Objectives�


Understand the general layout of a newsletter.�


Use the Newsletter Wizard to create a two-page layout.�


Use the design gallery to  enhance the newsletter layout.�


Insert a text file and clip art into existing frames.�


Review and edit existing text, including checking your spelling.�


Add a "drop cap" to a story to add visual interest.�


Add or delete extra pages.�


Convert your newsletter to a Web page.
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